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Welcome to the February/March edition of my monthly Final 
Cut Pro newsletter. This contains some new techniques, 
Reader Mail, and several tips that I didn't have time to fit in 
the first February issue.

The goal of this newsletter is to provide information helpful to 
the professional user of Final Cut Pro. This newsletter publishes 
each month. Past issues are not archived, however, key 
articles are posted to my website for your reference. All 
software references are to Final Cut Pro 5 unless otherwise 
noted. 

Please invite your friends to visit my web site --
 We now have over 100 tutorials - all free - 

to help you get the most out of Final Cut!
www.larryjordan.biz
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Wrap-up

This is sort of like two newsletters in three parts. While I really 
enjoy presenting my seminars, they take a LOT of time, which 
makes it hard to write. Still, we have plenty to talk about, so
let's get started. 

If you want to read the first half of this newsletter, . 
The last part will be out the third week in March. 

click here

Register NOW for Larry's  Seminars
Only 2 cities left!

Discover the Power

If you haven't already registered to attend one of our 
"Discover the Power" seminars, there are only two cities left – 
Orlando, FL, and Seattle, WA. 

We've created two seminars: one for beginning and self-
taught editors and one for intermediate to advanced editors. 

If you are looking to polish your skills, organize your system, 
edit and trim faster and improve outputting, the "Supercharge
Your Editing" seminar is for you. 

If you are looking for ways to use the latest technology to 
gain a competitive advantage – from HDV and HD to 
LiveType 2 to Soundtrack Pro – "The High-End of Final Cut 
Pro" seminar is designed for you.

Click here to learn more: www.larryjordan.biz/seminars

As one of the attendees to our Chicago, Illinois, seminar 
wrote:

If you use Final Cut Pro and don't attend this 
seminar, whatever you did, you wasted your day!

I would enjoy the chance to meet you. Click here to register.

[ Go to Top. ] 



Larry's Seminar Tour Comes to Australia!

After a very successful seminar series here in the US, Young 
Australia Productions has invited me to bring our Final Cut Pro 
seminar tour to Australia. This four-hour seminar will be at the 
Mercury Cinema in Adelaide, April 7, 2006. Tickets are $275 
(AUS) and seats are limited.

At this seminar you will discover productivity secrets and 
techniques you never knew existed in Final Cut -- how to 
optimize your system settings, how to organize your files, how 
to edit faster, trim faster and improve your output. The same 
subjects that have helped editors across the US improve their 
productivity!

In addition to this seminar, Larry has reserved three extra 
days for private staff training. If you are interested in 
customized training -- specifically tailored for your staff -- this 
training is perfect. We will be in Sydney, Melbourne, and 
Adelaide.

To learn more, reserve your seat, or sign up for training, 
please contact Young Australia Productions Pty. Ltd. for more 
information:

Phone: (+618) 8244 7880
Fax: (+618) 8244 7870
Email: info@youngaustralia.com.au
Website: http://www.youngaustralia.com.au

[ Go to Top. ] 

Technique: Creating Text Favorites

This technique grew out of a 
conversation with , of New York City, who 
started it by writing:

Gloria Messer

Your latest newsletter is fabulous, as usual. The fact 
that I could not change colors, fonts or sizes in a 
scroll in FCP has always been a source of 
frustration. I am thrilled by your solution. Now, why 
didn't I think of that???

Is it possible to center a name on a line under a 
lower-third title? Would you just skip a line on the 
2nd scroll on V-2, or would you use the asterisk and 
how?

 Gloria, your question gave me an incentive to 
relook at the text tool. And I discovered two features that I 
Larry replies:



didn't know existed.

First, though, to answer your question, the text generator in 
Final Cut has been generously described as "limited." While all 
scrolling titles are centered, lower-third supers are only flush-
left, for no rational reason that I can understand.

However, here's the cool part. Did you know you can create 
Text and Drop-shadow favorites? Neither did I. But, if you 
have a lot of text titles, or drop shadows that you want to 
add, using Favorites is a very convenient way to do it.

Here's how.

1. Create a text clip, click the  tab in the Viewer 
and style it however you want. 

Controls



In this case, I'm using  point  as a full-screen 
title to a Snowboard sequence.

80 Impact

2. With the text clip still in the Viewer and the Viewer 
selected, select .Effects > Make Favorite Effect

3. In the  folder, a new 
item shows up which is the text favorite you just created.

Browser > Effects tab > Favorites

4. Drag it from the Favorites folder into the Browser. You 
can now use this just like any other clip -- except your 
text settings are now preset. You can rename it, if you 
wish. 

5. Put your playhead in the middle of the clip in the 
Timeline over which you want to superimpose the title 



you just created.
6. Edit the text clip to the Timeline by dragging it to the 

Canvas and dropping it on top of the 
overlay menu.

Superimpose

7. Double-click the text clip to load it back into the Viewer.

8. Select the Motion tab and click the 
checkbox next to to turn it on. Modify 
your drop shadow settings -- I recommend using an

 of , a  of  and an  of .

Drop Shadow

Offset 1.5 Softness 30 Opacity 90

9. When your shadow settings are set, select Effects > 



.Make Favorite Motion

10. Notice that a second clip appears in the 
 folder. It's called "Text

(Motion)." These are the drop shadow settings you just 
created.

Browser > 
Effects tab > Favorites

11. To help you remember, double-click the name of the 
favorite settings and change the name to "Drop Shadow."

12. Now, whenever you want to create a text title, simply 
edit the text clip from the Browser to the Timeline using 
the Superimpose menu in the Canvas and change the 
text in the Controls tab. 

13. And, to apply a drop shadow, select the text clip you to 
which you want to apply the settings and chose 

 (or whatever you 
named the clip.)

Effects 
> Favorite Effects > Drop Shadow

As a note, you will need to restart Final Cut for the Effects 
menu to recognize the changed name of the drop shadow 
favorite.

As someone who as grumbled countless times about not 
being able to save drop shadow settings, this is a wonderful 
timesaver! 



[ Go to Top. ] 

Final Cut Goes Intel - some words of caution

Currently, Final Cut Pro does not support any of the Intel 
Macs. Apple has announced that they will be making Universal 
binaries available for the entire Final Cut Pro suite of products 
no later than the end of March.

Universal binaries are special software that run on both 
current and Intel/Macintosh systems. 

However, Paul Saccone, Apple's Product Manager for Final 
Cut Studio, recently told Digital Media News that these 
universal binaries are a straight conversion from the existing 
software. There are no new features and no bug fixes. 

His comments suggest that there is NO reason to "cross-
grade" to this version UNLESS you currently own an Intel/Mac. 
As of this writing, there are only two Intel/Mac computers 
available: the iMac and the MacBook Pro. While both are fine 
machines, neither is my first choice for running Final Cut.

For this reason, my recommendation is to wait on cross-
grading or purchasing Intel/Macs until later this year as we get 
a better picture of how the Macintosh product line, and Final 
Cut Pro, fit into the conversion to Intel processors.

For more information on Apple's cross-grade program, click 
here: http://www.apple.com/universal/crossgrade/

[ Go to Top. ] 

This Month's Poll: What do you want to learn about FCP?

Just a reminder that this is part 2 of our February newsletter. 
So, we are still looking for feedback on our current poll. I'm 
trying to discover what subjects you are interested in learning 
about so I can add these topics to future books, DVDs and on-
line materials.

You can take the poll here: http://www.pollmonkey.com/
p.asp?U=5079126756

And you will see the results as soon as you vote. 

I'm grateful so many of you have already voiced your 
opinion. It really helps me determine what this website covers 
and I appreciate your opinions.
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Reader Mail

LiveType Workflow

, from Florida, writes:Rudy Picardo

I've got a work flow question for you in which I was 
hoping you could give a suggestion. I'm working on 
a video with a few sections that are very similar to 
MS PowerPoint slides. I'm creating the text with 
animations using LiveType. I also have a voice-over 
narrator reading the lines corresponding to the text.

I'm having trouble timing the live-type and 
narration exactly.

Is there a work flow solution where I can put the 
audio track in LiveType and sync up the animations? 
I have the full Final Cut Studio Suite, so if you can 
think of a better work flow solution, I would 
welcome it.

As always I love your advice. I keep your HOT for 
FCP in my office and ran into your section on using 
Markers with DV detection. I just used it to import a 
large capture and saved me some time! One of my 
supervisors boasted that I'm a fantastic editor (even 
though I'm one of two editors in our small group). 
Regardless, I know that your materials have made
me a better editor.

 Rudy, LiveType does not support audio. 
However, Motion does. Since you have Final Cut Pro Studio, 
you can use Motion to create your sequences, then import 
them into Final Cut.

Larry replies:

Or, you can lay the audio into FCP, enter Timeline markers to 
show where you want the animation to start vis a vis the 
narration. Export the timeline, with markers, to Livetype (

) and build your animation using the 
markers as sync points.

File 
> Export > for LiveType

- - -

Reader Tip: Saving Favorite Effects Between Projects

, our favorite XML wizard, writes:Andreas Kiel

Within [After Effects] you can save sets of filters in 



a way which reflects the order of the filters, with 
FCP you can only save favorites, which [if you are 
not careful, are easy to get out of order.] The 
result might be a long list of favorites with no real 
relation or explanation.

But it is quite simple to change that. As I'm a 
master of XML here is the XML workaround and a 
standard workaround:

If you have a "favorite filter setting" for a clip, select
the clip and press "cmd-C", create a new slug [from 
the Video Generators pop-up menu in the lower 
right corner of the Viewer] within a new sequence 
and Edit > Paste attributes > Filters. 

[This copies all your filter settings into the new clip.] 
Then give a descriptive name to the clip and drag it 
into the Browser directly or into a new bin in the 
Browser. If you want, you can add a descriptive 
name to the bin. To add comments to a bin or a 
clip, press "Cmd+9".

[This creates a favorite which won't disappear when 
you trash preferences and it works fine for other 
clips in this project.]

[However, if you want to move these favorites 
between projects,] export either the bin or selected 
slugs as XML and give a descriptive name to the 
export. When you create a new project import this 
XML file, then select a slug containing the effects 
you want to apply to a new clip, press "Cmd+C",
then select a clip or clips and paste attributes.

 I've known about storing effects in clips for a 
long while. However, using XML to move selected clips or bins 
between projects is very cool. Thanks!

Larry replies:

[ Go to Top. ] 

- - -

Sending to Soundtrack Pro

, from LA, writes:Lou Dulien

I'm having a problem sending audio clips to 
Soundtrack Pro in order to do noise reduction. I've 
watched and downloaded the QuickTime tour of 
Soundtrack Pro that demonstrates how to do this, 
off of the apple site. The only problem is, when I 
control click on the audio clip, my only option for 



sending it to Soundtrack Pro is: "Send to soundtrack
pro multi-track."

I can't figure out why I can't send to Soundtrack Pro 
audio file. I think this is the reason I'm not getting 
the same results as in the QuickTime tour. HELP!

 Lou, a Soundtrack Pro audio file project can 
only contain ONE audio file at a time. Because you are 
selecting more than one audio clip, Final Cut is forced to send 
it to a Mutlitrack project. 

Larry replies:

Either send one file at a time or create a Soundtrack Pro 
script and send the files to the script. (I'll be writing about 
Soundtrack Pro scripts in next month's issue.)

- - -

Is MiniDV digital?

 writes:Max Tromba

I was having an argument with a buddy the other 
day whether MiniDV is stored as digital data onto the 
MiniDV tape? By the way, I really enjoy your 
Lynda.com training classes.

 Whoever said it is stored digitally wins.Larry replies:

- - -

Exporting to H.264

 writes:John Thomas

I have really enjoyed your tutorials on Lynda.com 
and your newsletters. I’m fairly new to FCP (about 1 
year). I was wondering what would be the best
settings to export a movie using QT H264? 

 This whole business of determining the best
settings to use for video compression is a complete morass. 
Probably my most asked question is to provide a one-
paragraph answer on the best compression settings for the 
web. Unfortunately, it isn't that easy.

Larry replies:

Ben Waggonner has written two excellent books covering 
video compression: 

and . Both are available on 
Amazon.com, as well as local book stores. 

Compression for Great
Digital Video Sorenson Squeeze 4

However, in the interest of providing some initial help, here 
are the settings I used to create a simple H.264 movie of a 30 



second commercial created by one of my students (David 
Bacon). These converted a 30 second DV movie at 115 MB 
into an H.264 movie at 4.3 MB.

First, remember that creating H.264 requires Quicktime 7, 
with the Pro version installed. You get the Pro version 
automatically when you install Final Cut. I loaded the movie 
into QuickTime Pro and selected . File > Export

I then clicked on the  button and set the Video 
options as you see on this screen here. (Notice that I didn't 
change the frame rate, with H.264 there is not a significant 
reduction in file size by decreasing the frame rate.) 

Options

Then, I clicked the audio options. As this was principally 
music, I used the QDesign Music 2 codec. I set the sample 
rate to 1/2 the sample rate of the timeline: . 24,000



As this video was for the web, I reduced the 
frame size to , which helps reduce the file size. I 
generally don't add filters when using H.264.

320 x 240

While you will have more control using Compressor, this is a 
fast way to convert a video into an H.264 movie. On my G-4 
PowerBook, it took about three minutes to convert the 30 
second movie into an H.264 movie.

[ Go to Top. ] 

- - -

Setting Scratch Disks

 writes:Joel Wycoff

I FINALLY got around to implementing your 
technique as described in "

."
Archiving and Organizing 

your FCP Project

I came up with one question, when I "set" the 
scratch disks, it's done with System Settings. So if 
we work with more than one project, we take the 
chance of dumping into the wrong folder. Because 
system settings take precedence over projects. 
True?

For example, we start a new project for the youth 
group JSM_001_Feb, then later that afternoon, we 



go back to work on V&R_Wedding, the system 
setting are still point to JSM_001_Feb. So any 
rendering, etc, takes place over there.

So I need to establish process guidelines for my 
team? When they go to work on project A, first 
make sure sys setting are pointing to proj A , before 
they do ANYTHING.

Am I on track here?

 You are close, but not on track. While it is true 
that Scratch Disks are system-, rather than project-, based, 
here's how scratch disks work.

Larry replies:

Create a folder on your second drive, the one you use to 
store media, and call it "Final Cut Pro Documents."
Point your scratch disks to that folder and NEVER change 
it.
Final Cut ALWAYS stores media in a folder named after 
your current project. So, when you capture media, Final 
Cut puts it in a folder named after the active project in 
your Browser. (The active project has a light gray tab 
and is in front of any other open projects).
When you switch projects, either by opening a project 
file, or clicking on a tab in the Browser, Final Cut 
recognizes this change and now stores any new capture 
files in the project file in your capture scratch folder that 
is named after your now current project.

In other words, you don't need to do anything -- the files are 
stored correctly by project in your capture scratch and render 
folders.

This procedure is also true for render files. All render files 
(both video and audio) are stored in folders named after your 
project. So, whenever you change projects, your render files 
switch to the appropriate folders for that project. 

However, one thing you must do BEFORE capturing any 
media for a new project is to save the project and give it a 
name. That way, Final Cut knows what to name the folder it 
will use to store media in your Capture Scratch, and render 
file, folder. If you don't give your project a name, Final Cut 
will name it for you -- by calling it "Untitled Project #."

Finally, keep in mind that Final Cut stores the complete path 
name to all your media files in the Browser. So, once a file 
has been captured, Final Cut knows exactly where it is stored, 
regardless of what the folders are named. This means that 
you don't need to change the scratch disks in order for FCP to 
find files. It already knows where they are.
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- - -

Video Offset problems

 writes:Paul Devlin

Just want to point out what seems to be an 
inaccuracy on this page:

http://www.larryjordan.biz/articles/
lj_view_menu.html

What I've observed is that the Frame Offset does 
not affect audio at all. Instead, it delays the video 
on the Canvas by that number of frames in order to 
synch up with the delayed video signal on the 
external monitor. 

The result, unfortunately, is that the Canvas video 
is now out of synch with the Built-In audio. As a 
result, this feature is essentially useless in my 
opinion, since who wants to edit with out of synch 
built in audio.

It would be much more useful if the audio were 
delayed, as you erroneously describe, but 
unfortunately this is not the case as far as I can tell.

Avid is able to delay audio in this way to synch up 
with the external monitor. It would be nice if FCP 
could do the same.

 Paul, the FCP manual is somewhat murky on 
this subject (page 220). My understanding was that this delay 
affected only the external video, not the video displayed in the 
Canvas. As I am on the road at present, I don't have the 
ability to test this, but am publishing your comments as a 
heads-up for other readers. 

Larry replies:

If anyone has additional information, please let me know.

[ Go to Top. ] 

- - -

Flickering Images

 writes:Inaki Vizarra

I currently run FCP 5.0.4 and I have an annoying 
problem that it seems I cannot trouble shoot. When 
I make freeze frames, sometimes but not always, 



there is a flickering in parts of the image; i.e. a 
hand holding a folder flickers left and right. You can 
see this in your external monitor but not in the 
viewer nor the canvas, but it gets recorded into 
tape. It looks like white spots of video signal flicker 
inside the frozen frame, like the luma is too high. I 
have tried color correction in various ways, color 
correction "broadcast safe" but I can't solve the 
problem. Is something that you have heard of 
before?

 What you are seeing are interlace artifacts,
caused by the fact that NTSC and PAL video are both 
interlaced. That is, they display first all the even lines of an 
image, then the odd lines; rather than displaying all the lines 
in order from top to bottom.

Larry replies:

Your computer monitor displays all lines in order, which is 
called "progressive" display, as opposed to your TV monitor, 
which shows the lines in an "interlaced" display. That's why 
you don't see the problem on your computer monitor. 
Interlacing is only an issue on a TV.

This is why I stress to all my students that they MUST look at 
their sequences on a video monitor, which shows interlacing, 
before making any final output to tape. (And, by the way, why 
I object so strenuously to manufacturers who are trying to 
convince us to buy LCD-based video monitors. An LCD monitor 
will never show interlacing, which means I can not use it for
making final quality decisions on my projects.)

Anyway, to fix this problem for still frames, you can apply a 
deinterlace filter, which removes half the lines from your 
image (either even or odd) which has the affect of removing 
the flicker. Or, you can use a flicker filter which also kills the 
interlace effect. You will find both in Effects > Video Filters > 
Video.

Try them both and see which one makes your image look the 
best - remember, you must view these on a video monitor, 
not your computer screen, to see the final effect.

[ Go to Top. ] 

- - -

Deinterlacing video

, from Auckland, New Zealand, writes:Mike Reeves

I want to run the deinterlace filter on a [PAL] 
project I have so that it can be viewed on a 
Quicktime movie put to CD - eg view it on a monitor



without the jagged lines.

I know Pal DV is interlaced and lower field dominant. 
My question is does the Deinterlace filter in FCP 
remove the field it is set to so that if I run the filter 
with upper set in FCP does this remove the upper 
field or does it keep the Upper field. I have 
searched high and low and have found various 
solutions which contradict each other. One person 
says run the filter with "upper" set and the other 
says run it with "lower" set. I also read an article 
about the "Joe's interlacer' which says that FCP field 
are the opposite to the Joe's filter. Apple of course 
won't commit themselves, they just say run it - OK I
will run it - but do I set the Upper or lower option in 
FCP?

 Mike, the deinterlace filter just deletes every 
other line in your video image. What you are doing is selecting 
which set of lines you want it to delete. Pick the one that looks 
the best -- I generally select ODD (or upper), but the choice is 
yours.

Larry replies:

Also, if all you are doing is outputting video to compress for 
the web, if you are compressing your PAL DV movie into a 
320 x 240 (NTSC) or 320 x 288 (PAL) version, you don't need 
to deinterlace. The process of compressing to that small an 
image size will automatically throw away ever other video line.

- - -

Reader Tip: Sharpening your video

While I don't, as a rule, sharpen video because it makes the 
edges too harsh in my opinion, there might be situations 
where you want to add a bit of "snap" to a still image. Mike 
Reeves recommends using the Unsharp filter (

) 
with settings of , , and

.

Effects > 
Video Filters > Sharpen > Unsharp Mask

Amount = 100 Radius = 0.5
Threshold = 0

- - -

Consumed by Guilt Department

Last September, Jon Kagi, of , sent me a DVD to 
review called "Mix it Like A Record." It wasn't until this week 
that I actually had time to sit down and look at it.

Kagi Media

If you are into creating music, you'll find this DVD an 
invaluable aid to improving the quality of your mixes. While it 
focuses on using ProTools, especially the high-end version -- 
ProTools TDM, it's overall message can be useful to anyone 



 

creating music.

The DVD is hosted by Grammy-winning mixer Charles Dye as 
he walks you thru the history, theory, and techniques of 
mixing music.

While this title is overkill for many video projects, there's still
plenty to learn. While I found the video images and editing to 
be a bit over the top, the narrative pacing is slow enough to 
allow time to really comprehend his message. This title does a 
great job of conveying the importance of emotion and subtlety 
in the audio mix and a much greater understanding of the 
audio tools that are out there.

The retail price is $149. To learn more about 
this DVD, visit: .http://kagimedia.com

[ Go to Top. ] 

- - -

Rendering in LiveType

, from Suffolk, VA, writes:Skip Hall

I have a one-minute LiveType creation that is taking 
over an hour to render.  I started with a LiveType 
template, then added a number of tracks, each with 
effects.  Then stretched the time to fit the spot I 
had for the credits on the timeline.  I "played" the
timeline in LiveType and got a green bar.  I saved 
the piece, then imported it into FCP5.  When applied 
to the timeline, the bar was orange ("unlimited") 
over the LiveType piece. 
 
It has been rendering for over an hour now in 
FCP5, is showing no progress at all on the timeline 
(orange bar is still fully orange), despite the fact 
that the render progress window says 39%, the 
estimated time is still reading "about an hour."  
There is no way this G5 should be choking up like 
this unless I am doing something seriously wrong.

 Skip, there could be a number of things going 
wrong here. The key phrase is that after an hour of rendering 
nothing is showing up in the progress window.

Larry replies:

It COULD be that your effect is so humongous that FCP is 
simply overwhelmed with the enormity of your creative 
prowess. On the other hand, here is a quick fix and a 
workaround.

First, make sure that the Project Settings of your LiveType 

 



project match the settings of your Final
Cut sequence. ( ). 
Make sure that the pop-up menu says  for DV 
footage, or  for Betacam (or whatever is the 
appropriate setting for your sequence.) Generally, these are 
not set correctly during install.

Livetype > Edit > Project Properties
DV NTSC 3:2

CCIR 601

Second, for a quick fix within Final Cut, try trashing your 
preference files. Here's an article that describes how 
to do it: http://www.larryjordan.biz/articles/lj_trouble.html

Third, if the first two solutions don't fix anything, export and 
render your movie in Livetype then import the resulting movie 
into Final Cut. ( ). If you 
are keying your Livetype animation over video in Final Cut, 
you will still need to render it, but that process should be 
much faster than what you are seeing now.

LiveType > File > Render movie

- - -

Reader Tip: Soloing a clip

 writes:Dave Hardy

You mention that you can make a clip invisible by 
control clicking it [turning off ] from the 
contextual menu, but you can also do this by 
selecting the clip & pressing  which will 
toggle clip visibility on & off. 

Clip Enable

Cntrl+B

Likewise  toggles Solo for that clip -- turning
everything else off or on. I'm sure you already 
know this but being short on time to get this months 
newsletter out decided not to mention it.

Cntrl+S

 Dave, I did not know this trick so thanks for 
sharing it.
Larry replies:



What  does is turn off Clip Visibility for  video or 
audio clips stacked above or below the selected clip on all 
tracks  the clip you click on. This makes it easy to see 
what's under a particular clip.

Cntrl+S all

EXCEPT

[ Go to Top. ] 

- - -

Color Correction

, from Miami, writes:Rudy Picardo

First, I wanted to say thanks again for your 
newsletters. I'm already planning to use your article 
on multi-colored text scrolls on a project I'm working 
on.

I've got a color correction question, as I'm still new 
to this. I've used techniques which I've done my 
best to follow based on your two articles on color
correction and match hue on your site.



Here's a file which contains the master shot (color 
corrected slightly) and the a shot from a secondary 
camera, which I've attempted to color match with 
the master shot. In the secondary camera, I'm 
getting an "ok" match with the blue blazer she is 
wearing, but the rest of the shot seems off.

I'm having problems and was told that I may have 
to use Secondary Color correction, which I've never 
heard of. Is there such thing as Secondary Color 
correction, and if so, is this discussed in any of your 
training materials?

 Rudy, before you worry about secondary color 
correction you have a bigger problem. 
Larry replies:

Look at the color of her skin in the close-up camera. It is blue 
trending magenta -- you are getting a significant amount of 
daylight spill from what appears to be a nearby window. Her 
shirt collar is also quite blue, and the exposure on her face is 
not the same. The  important thing in color correction is 
getting skin tones to look right, not clothing. 

most

Try doing a color correction using the white collar of her shirt 
as your reference. I think you'll find that using the automatic 
white sampler eyedropper in the 
filter will make her skin tone in these shots match fairly 
closely.

Color Corrector 3-way

Here's the article that describes what to do: http://
www.larryjordan.biz/articles/lj_color.html

[ Go to Top. ] 
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Color Correction Workflow

, from Starke, Florida, writes:Victor Spangler

I wrote you a question a couple of months ago and 
you didn't have a working response to my problem. 
The problem was this. I had some clips that I 
wanted to send to Motion from Final Cut and they 
had already been color-corrected. When I imported 
them into Motion I would lose the color correction. 
(You told me to color correct after coming back out 
of Motion) 

However, when you correct after coming out of 
Motion your lower third title shifts colors as well. 

Well, I have come up with a way around this 
problem. First, I copy the clip that I want to send to 
Motion. Next, I paste it in position directly above the 
original clip in the Final Cut timeline...then I send 
the copied clip to Motion. I use the copied clip for a 
reference in Motion and build my graphics, then 
when I am finished I "UN-check" the box for the 
copied clip in Motion to be seen. 

The reference video goes away on the screen. This 
will produce an alpha channel with the graphics 
which I save and then go back into Final Cut. The 
copied clip now has the graphics with the alpha 
channel and the original color corrected clip is below 
and it looks great. Of course you have to render the 
two together BUT, I now have a color corrected clip 
with graphics that haven't shifted colors.

 Victor, this is a great tip. You can use this same 
technique to create titles in LiveType as well by going to 

 and either 
(to include) or  (to exclude) the background video. 

Larry replies:
Edit

> Project Properties checking
unchecking
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RAM Questions

 writes:Todd Burns

I'm a former student of yours (Santa Monica 2004) I 
just installed another 2 total gigs of RAM to my 
system  (Mac G5 Dual Processor) which gives me a 
total of 4 Gigs DDR-SDRAM. I recently Installed 
Tiger & Final Cut 5...My CPU Speed is 2GHz, Bus 
Speed 1GHz.



Can you explain exactly what Inactive RAM is?  Right 
now my Inactive Ram is 2.8 Gigs & my Active RAM is 
only 700Mgs. and the only thing open is Final Cut 5.  
Does it slow the machine down if there's a large 
percentage of the ram that's inactive?  Is there any 
way to make more of the ram Active & less Inactive 
or does the system just do all of that on it's own? 
My machine is running faster since adding the extra 
ram but it still seems slower than it used to be 
when I had Jaguar & Final Cut 4.

 This is so cool -- I just learned what all this 
means myself and it's a great tip.
Larry replies:

First, an important note. While OS X 10.4 supports more than 
4 GB of RAM on a system, Final Cut Pro does NOT support 
more than 4 GB of RAM. I have a number of clients who have 
installed more RAM and they are having problems. My 
recommendation is to remove all RAM in excess of 4 GB until
Final Cut is able to support the additional memory.

Also, G-5's are notorious for being finicky about RAM. Make 
sure you buy from a reputable vendor, and don't buy on price. 

Next, I have a new best friend... It used to be Disk Utility, 
but now it's Activity Monitor. Run it by going to 

. 
Utilities 

folder > Activity Monitor

The top portion displays a list of all currently running 
processes -- which changes every few seconds. While trés 



cool, this is not the focus of our interest at the moment.

Instead, click on the System Memory tab. The lower portion 
of the display shows four memory states. Here's what they 
mean:

 is that portion of memory which is assigned to 
active RAM and can not be paged out to disk. Most often 
this is assigned by the operating system.

Wired

 is that portion of memory assigned to currently 
running programs that is currently busy meeting the 
memory needs of those programs.

Active

 is memory which is assigned to a program, or 
process, but which is not busy at the moment. Think of 
this as memory in reserve.

Inactive

 is memory which isn't assigned to anything and is 
available for general use.
Free

What I've started to do is to run Activity Monitor along with 
my other applications to see how much memory my 
applications are currently using. This has been an eye-opening 
experience.

Here's an easy way to interpret the graph. If your memory 
graph is predominantly red and yellow, you need to add more 
memory. Your system is maxing out and you are probably 
taking a performance hit.

If the graph is mostly blue and green, you have sufficient 
memory for the tasks you are running and you probably won't 
see any performance benefit by adding new memory.

For instance, when I am editing DV, my memory allocations 
are modest. As soon as I start editing HDV, the memory 
requirements go through the roof.

I LOVE learning stuff like this!!
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Using Frame Offset

 writes:Paul Devlin



Just want to point out what seems to be an 
inaccuracy on this page:

http://www.larryjordan.biz/articles/
lj_view_menu.html

What I've observed is that the Frame Offset does 
not affect audio at all. Instead, it delays the video 
on the Canvas by that number of frames in order to 
synch up with the delayed video signal on the 
external monitor. 

The result, unfortunately, is that the Canvas video 
is now out of synch with the Built-In audio. As a 
result, this feature is essentially useless in my 
opinion, since who wants to edit with out of synch 
built in audio.

It would be much more useful if the audio were 
delayed, as you erroneously describe, but 
unfortunately this is not the case as far as I can tell.

Avid is able to delay audio in this way to synch up 
with the external monitor. It would be nice if FCP 
could do the same.

 Paul, my understanding was that the frame 
offset actually did delay the video output. Clearly, we can't 
both be right, so if any reader has additional information, I'd 
like to know about it so I can update the article.

Larry replies:

- - -

Help needed in syncing audio and video files

, from Uruguay, writes:Fabián Oliver

I'm sound mixer , i work with a Fostex PD6 
recorder that records T/C BWF files.

I use a time code slate when we shoot film. Here in 
my country we sync audio and telecine in NLE ( not 
in the telecine process, so transfers come MOS), 
most of it are Final cuts.

My question is: what's the fast method to 
synchronize audio and video using the T/C slate and 
files converted with Sebsky tools in FCP?. I know 
that Avid has the autosync feature that save lot's of 
time.

Can you give me a tip that I can translate to the 



editors??

 Fabián, I don't know. But let me ask our readers 
to see if someone has a suggestion. And, you might check out 
the next comment from Andreas Kiel. 

Larry replies:

- - -

Convert Broadcast Wave files for FCP 

, author of an 
for Final Cut, recently sent me an announcement of a product 
which converts BWF (Broadcast Wave files) for use in Final 
Cut. He writes:

Andreas Kiel excellent series of XML utilities

BWF2XML is the reliable, fast and simple way to 
convert Broadcast Wave Files into a format that 
allows Final Cut Pro to work effective with those BWF 
audio files.

By leveraging the power of the Final Cut Pro XML 
format, BWF2XML allows Final Cut Pro to seamlessly 
import the complete metadata set as well as the 
original timecode stamp. Dependent on the system 
setup polyphonic BWFs and merging of discrete 
mono BWFs are handled.

The new version matches the timecode settings of 
all major audio HDRs and allows a smooth match 
between those HDR settings and the Final Cut Pro 
timecode options. A “Target Project” option has been
added as well, this allows to streamline the 
workflow even better than previous versions.

These new features do extend BWF2XML’s currently 
unique feature set - like “Metadata Mapping” and 
“Non Destructive Premix” - which makes this 
application the most advanced application for 
handling professional BWF audio in a Final Cut Pro 
editing environment.
BWF2XML just makes complex procedures appear 
simple and easy to use.

For more information about the product and system 
requirement please visit 
the products homepage: http://www.spherico.de/
filmtools/BWF2XML/
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Problems with Cinewave



 writes:Luis Marrou

Hope you can help me. I am trying to capture video 
YUV Balance and it won't let me. It captures DV50, 
no problem. I am capturing from a beta sp source, 
have a G5 Dual, Cinewave 4.7. FCP 4.5. Any ideas.

 Sadly, Luis, the Cinewave card is not supported 
in current versions of the Mac OS. The problems you are 
having is that you updated to an OS version that Cinewave 
does not support. Pinnacle, the maker of the Cinewave card, 
stopped updating their drivers around OS X 10.3.7.

Larry replies:

My recommendation is to switch to 
either an or capture card.AJA Blackmagic Design

- - -

Audio Sync Issue

 writes:Barry Drennan

I have an audio synch problem on music 
videos made in DVD Studio Pro 3. The duration of 
my movies are often an hour or longer and I use 
Compressor to compress them in the MPEG 2 high 
quality preset. Unfortunately the audio always lags 
on the final product although it's perfect on the 
computer in simulation mode. I have a G5 with 
1.5 GB of memory running Tiger. If I export from 
FCP in quicktime movie mode then there is no audio 
problem but I generally can't use this mode as the 
files are too big to fit on the DVD.
 
Your comments and advice would be gratefully 
appreciated.

 Barry, this audio sync drift is a known problem 
when exporting to Compressor directly from Final Cut HD.
Larry replies:



A much better workflow is to export your sequence as a 
QuickTime Reference movie (

 and UNcheck "Make Movie Self-Contained."
File > Export > QuickTime 

Movie

This creates a very small file on your system that you can 
then into Compressor and compress into an MPEG-2 file 
using your standard presets.

drag
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Converting 30 fps to 24 fps video

The following dialog clarified for me when to use Cinema 
Tools and when to use a filter.

 writes:Wayne Johnson

I want to convert my 29.97 footage to 23.98 
footage using Cinema Tools. However, I keep 
getting a jerky image whenever the camera pans 
and so on. Could some one point me in the direction 
for this process.

 Wayne, I've forwarded your question to 
, who knows more about this than I do.

Larry replies: Noah
Kadner

 replies: Noah

This helped me out in learning Cinema Tools: http:/
/www.lafcpug.org/pana_cinetools.html

 wrote back: Wayne

This is helpful, but my footage is 29.97, I want to
make it 23.98 then bring it back to 29.97.

The goal is to capture the most data possible and do 
the conversion in post for the "film look" I could be 
crazy but, I think the point of the camera is to 
capture the highest quality data possible with no 
conversion. 30i or 60i. Then edit your project, add 
effects, color correction and so on. then if you want 
the look of film adjust the frame rate.

 responded: Noah

I got the impression you were asking how to resolve
the pulldown out of footage from a 24p camera. 



But it sounds like you're actually asking how does 
one make footage from a 60i/29.97 camera look
like 24p visually. In that case Cinema Tools is not 
what you would use. It's purpose is for the former 
and is not intended for the latter.

You need a "film look" plugin. This is applied at the 
very end of your edit because it's very processor
intensive and time-consuming. Here's a couple to 
look at in order of my personal preference:

Graeme Nattress' Film Effects

http://www.redgiantsoftware.com/mbforeditors.html

Hope that helps!
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Removing Pulldown from PAL video

, from Bel Air, France, writes:Pat Berning

Thanks for the first issue of  which, with it's 
reader-friendly format and interesting articles, is 
just as great as your newsletter.

Edit Well

A quick question re the article on 24p. It's obviously 
geared for NTSC so what differences are there for 
the PAL format?

 Pat, I'm sending your question to Noah, who
wrote the article for .
Larry replies:

Edit Well

 replies: Noah Kadner

The differences [between NTSC and PAL] are pretty
huge actually. Since 25p divides exactly 1:1 into 50i 
PAL there is no pulldown to remove and no 
advanced mode. 
The DVX100 PAL model shoots 25p and 50i, period.

- - -

Nesting Sequences in Other Sequences

 writes:Kathleen McNamara

Could you answer a question about copying 
sequences in the timeline. On page 407 of your Final 
Cut Pro 5 book, you describe editing in separate



sequences and then combining them for final output 
(which I'm proud to say I was already doing). 

The picture shows the new sequences copied as 
single clips, instead of as many individual clips. The 
first time I did this it worked fine, just like your 
picture, but now when I copy the sequence it's 
identical to the edited sequence, a bunch of clips. 
Does it have something to do with "Clip enable" in
the modify pulldown menu?? I'm baffled.

 It has nothing to do with Clip Enable. Clip 
enable simply makes a clip visible or invisible. 
Larry replies:

If you drag a sequence into another sequence, it will appear 
as a single clip.

If, however, you drag the sequence from the Browser into 
another sequence, then press the  key before 
letting go of the mouse, the sequence will automatically 
deconstruct into its individual component clips. This is a very 
fast way to unnest a group of clips.

Command
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Soundtrack Pro Filters

 writes:Reid Kramer

Larry, does SoundTrack Pro have a Time 
Compression/Expansion filter, and does it have a 
Pitch shift filter?

 Yes. Soundtrack Pro has a filter called "Pitch
Shifter," and it has a time compression/expansion tool in the 
toolbar which allows you to adjust whatever word, phrase, 
sentence or clip you have selected.

Larry replies:



By the way, here's a heads up from  from 
the South Australia Police Audio Visual Unit:

Jacob Hodgman

By the way, the Vocal Transformer effect in STP is 
absolutely BRILLIANT for disguising voices (bad 
guys/anonymous informants etc) - only small
adjustments to the settings provide fantastic 
changes that disguise while still keeping voice quality.

 I thought that was just too cool a tip from a 
decidedly "official" source for me to resist!
Larry, again:

- - -

Problems with Compressor 2

There have been reports of compression problems using 
Compressor 2 that I want to bring to your attention. Based on 
this, my current recommendation for Compressor 2 is to not 
use any of the  settings, but to use  instead.Best Better

Here are the relevant quotes from a recent discussion 
between several Apple trainers.

: Ben Balser

I've gotten a few questions lately about Compressor 
2. Specifically bad quality MPEG-2 encodes and 
pixelation on transitions. Personally I haven't had 
any problems. But a few users have approached 
me with this problem. Wondering if anyone knows 
what's up with this?

: Chris Roberts

I have noticed this problem with compressor 2 - but 
only when using the High Quality (2 pass) presets. 
Apparently I heard on the Digital Production Buzz 
podcast that this was a bug with the encoding using 
the 2 pass process in Compressor 2 and the advice 
was to stick with a constant bit rate which I have 
been doing. Has anyone else heard this and if so 
has it been fixed as I was asked about it myself only
yesterday?

: Noah Kadner

I can confirm this as well. Just did a 4:3 NTSC DV 
project on the Two-Pass HQ preset that showed tons 
of artifacting on transitions. Knocking it down to a 
7.0 Manual CBR looked perfect.
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Audio Beeps

 writes:Gerard Blitz

Sorry to bother you again but when i play my clip 
all I get is beeps for the audio with the graphs 
blinking. I removed the original audio and inserted a 
new one but I can't hear it. Any ideas?

 Gerard, audio beeps simply mean that your 
audio files need to be rendered. This can be caused by one of 
two things: 1) you have added an audio filter which is too 
complex to be played in real time, or 2) the number of audio 
tracks in your timeline exceed the number of real-time tracks 
you have specified in preferences.

Larry replies:

In  you can set the 
number of real-time audio tracks, the default is . Keep in 
mind that the more real-time audio tracks you set, the fewer
real-time video effects are available, as you only have one 
computer with finite resources.

Final Cut Pro > User Preferences
8

- - -

Optimizing your Processor

 writes:Andrew Ficklin



I was reading the "Optimizing your Final Cut Pro 
System" book, the Apple Pro Training Series. In the 
section for optimizing Mac OS X for Final Cut it 
stated that we should set the CPU setting to High as
opposed to Automatic. Do you suggest this?

 I agree, sort of. Larry replies:

You set processor performance in the  System 
Preference pane, by clicking the  tab. 

Energy Saver
Options

My recommendation is to set it to  if you have a 
G-5, and set it to  if you have a G-4.

Automatic
Highest
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Convert DV to HD footage

 writes:John Reed

Is there a way of 'interpolating' DV footage to HD 
size in FCP? I think this could be done frame by 
frame in Photoshop using GF PrintPro, but my copy 
of Photoshop won't batch process more than 1000 
frames.

 Sure -- but it's easier than this. Just edit your 
DV footage into your HD timeline. FCP will render it into an HD 
Larry replies:



format. You won't get any better quality, but you don't need 
to convert it before loading it into FCP.

Wrap-up

Well, that wraps it up for the second half of the February 
newsletter. I'm already working on the March issue, which will 
be out by mid-month. We've got some exciting stuff planned 
for the next few months and I'm looking forward to telling you 
about it.

Please consider 
 in Orlando and Seattle. You can learn 

more about them here -- the response has been
fantastic and it will be months before we start 
traveling again.

registering for one of our last two 
seminars

Or, join us for our Australian tour in April. 
 to learn times and 

schedules.

Contact 
Young Australia Productions

Also remember that our monthly poll is still open. 
Please share your opinions on this month's poll. I'm 
trying to figure out what you want to learn and your 
answers help. 

Click here for the poll: http://
www.pollmonkey.com/p.asp?U=5079126756

Finally, I'm grateful for all your comments and questions. I 
love hearing from you and when you share your ideas and 
suggestions, we all learn.

Thanks and edit well.

Larry
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